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Чем отличается магия от науки? Наука основана на опыте, наблюдении и поиске
закономерностей. Магия – это набор подходов. Множество простых юзеров в
общении с компьютером используют как раз магический принцип освоения ма-

териала. Следствием такого подхода к компьютеру (с бубном шамана) является харак-
терный осторожно-опасливый стиль поведения основной массы пользователей. Види-
мо не случайно многие фирмы стали называть свои системы помощи к программам
Wisard’ами (волшебник, колдун). Конечному пользователю, очевидно, легче понять за-
клинания Гэндальфа, чем логику Ньютона.

Рассчитывая свои статьи, прежде всего, на русскоязычных коллег из Израиля, счи-
таю особенно важным преодоление стереотипа, что графика – суть Photoshop и
FreeHand. Это какая-то магическая формула, волшебные слова, отворяющие, по мне-
нию масс, все ворота. Страх перед компьютером, подогреваемый нетехническим скла-
дом ума большинства и общей сложностью используемых технологий является неис-
черпаемым источником проблем, сильно сокращает арсенал средств дизайнера. За ка-
дром остается колоссальное количество программ, заслуживающих внимания, благо-
даря своим возможностям.
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Философский камень

Adobe Photoshop, без сомнения, сегодня (равно как и в прошлом), «царь горы», од-
на из самых стабильных, мощных, гибких, наиболее продуманных программ из всех су-
ществующих для РС и Macintosh. Правда, я отклоняюсь от провозглашенной темы – ма-
лоиспользуемые в Стране программы, но, как фан продуктов Adobe, мимо Photoshop’а
пройти не могу.

При всех своих преимуществах даже Photoshop имеет недостатки. Наиболее замет-
ный из них – высокая требовательность к ресурсам. Чтобы программа не обращалась к
виртуальной памяти, считается, что ей должно быть доступно в 5 раз больше RAM, чем
размер обрабатываемого файла (см.сноску). Однако, даже если памяти достаточно,
Photoshop все равно образует 800-килобайтный темповый файл на Windows и 1.2 Mb –
на Macintosh. Чтобы обмануть его, на Маке есть возможность создать виртуальный диск
(имеет смысл, если у вас далеко за 100 Mb RAM). Делается это в пульте (Control Panel)

Memory. После
перезагрузки
машины на ра-
бочем столе
появится RAM
Disk. Чтобы он
начал рабо-
тать, не за-
будьте сде-
лать его First
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Scratch Disk в Preferences Photoshop’а.
На Windows, для оптимизации, скорости нужно позакрывать все программы и выде-

лить Photoshop'у 100% памяти в Preferences. Однако могут возникнуть проблемы при
сканировании и на выводе. В этом случае отведите программе 80-90% свободной памя-
ти. На Macintosh желательно выделить Photoshop’у максимум RAM из возможного  и, на
обоих платформах, периодически перезагружать программу, чтобы уничтожить разрос-
шийся темповый файл. Когда рабочий проект большой, его долго сохранять и открывать
снова, тогда держите под рукой маленький файл и пересохраняйте его периодически.
Каждое сохранение любого из открытых файлов ведет к перестройке и оптимизации об-
щего файла подкачки. В любом случае, обработку файлов размером в сотни мегабайт
лучше производить на Маке, он гораздо скоростнее, а Mac OS надежнее РС и Windows.
Здесь, как нигде требуются перечисленные качества, всегда обеспечивавшиеся на
Macintosh и тут с ним не может соперничать РС, пусть даже с Pentium’ом III, но произве-
денный дядюшкой Лю из Шанхая и купленный за 3 тысячи шекелей.

Хорошую экономию даст работа в RGB с конвертацией в CMYK только в конце. Полу-
чается выигрыш, примерно, в четверть за счет лишнего цветового канала. Чтобы видеть
как это будет в CMYK, включите View>Preview>CMYK. Удаляйте лишние каналы и слои,
можно убрать участки нижних слоев, скрываемые верхними, а так же обрубить невиди-
мые участки растра, выходящие за пределы видимой области (если они, конечно, не
нужны) путем выбора всего (Ctrl (Cmd) + A) и обрезанию (Image>Crop). Все что было за
видимой областью – удаляется. Место в памяти занимает так же Snapshot (быстрый
снимок) генерируемый автоматически при запуске файла. Если вы его не используете,
удалите из палитры History. Перед выполнением какой-то тяжелой работы, требующей
больших ресурсов имеет смысл отчистить все буферы обмена и список History
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(Edit>Purge>All). Не забывайте, один только уровень отмены (Edit>Undo) представляет
из себя полную версию файла до последнего действия, сохраняемую полностью в па-
мяти.

Наконец, медленную перерисовку тяжелых картинок можно ускорить увеличив в
Preferences, во вкладке Image Cache значение Cache Levels (изменяется в диапазоне от
1 до 8). За более быструю перерисовку придется заплатить увеличением файла подкач-
ки.
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Эликсир молодости

Болезни «царя горы» (для любителей Толкиена – под горой) привели к появлению мо-
лодых конкурентов. Наиболее видные из них это: Corel PHOTO-PAINT, Life Picture и
Macromedia xRes. PHOTO-PAINT, правда не такая уж новинка. Я его видел еще в 4 и 5
версиях пакета CorelDRAW. С тех пор он изменился до неузнаваемости. К восьмой вер-
сии получился гибрид старого PHOTO-PAINT’a CorelDRAW, Photoshop’a плюс обработка
видео. Комбайн какой-то. PHOTO-PAINT 8 имеет контекстно зависимую панель кнопок и
интерфейс CorelDRAW, что видится его несомненным преимуществом. Кроме того, он
впитал в себя строение команд и чуть ли не все функции Photoshop, может редактиро-
вать видеоряд, как бы заменяя собой и Photoshop, и Premiere. Программа очень удоб-
ная, наверное единственная из всех понимает на 100% формат Photoshop’a (четверто-
го).

Но за сверкающим фасадом обнаруживаются недоработки, характерные для Corel.
Чем глубже лезем в программу, тем больше встречаем недоделок. По стабильности,
столь важной в области обработки растровой графики, с Photoshop’ом, конечно, не
сравнить. 

Существуют версии Corel PHOTO-PAINT 8 для Windows и Macintosh. Не имея шансов
на Маке он является, на мой взгляд, хорошим решением для любителей на РС. назад
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Золотой свинец

PHOTO-PAINT сравню с прусской армией под Аустерлицем: красиво, в строю, с раз-
вернутыми знаменами безуспешно атакующей Старую Гвардию Бонапарта. Продолжая
сравнение, Life Picture с xRes уподоблю русским партизанам с вилами, зимой уничтожа-
ющих тылы Великой армии Наполеона. Если PHOTO-PAINT идет «в рукопашную», атакой
в лоб пытается отбить рынок у Photoshop’a то двое других, как настоящие герои, идут в
обход. Они используют технологию обработки экранных образов, а не самих изображе-
ний напрямую, что дает очень заметный прирост скорости, позволяет, даже на слабых
машинах, работать с громадными файлами.

Life Picture – очень мощное Мак-приложение, являющееся прямой альтернативой
Photoshop’у. Его интерфейс и техника работы совершенно непохожи на то, что исполь-
зует «царь горы». Только разновидностей слоев там штук одиннадцать. Ввиду дорого-
визны, сложности освоения и невозможности редактирования напрямую стандартных
форматов файлов Life Picture не получил широкого распространения.

Macromedia xRes напротив, позиционируется на рынке как дополнение к
Photoshop. Очень похож на его третью версию действием и на седьмой FreeHand интер-
фейсом. Вся хитрость xRes спрятана в меню Modify  >  Work Mode  > . Режим Direct, как
вытекает из названия, это редактирование изображений напрямую, как в Photoshop’е.
xRes в режиме Direct работает в двое медленнее, чем Photoshop и никакого интереса не
представляет. Второй режим, который так и называется «xRes», переключает одноимен-
ную программу в режим работы с экранными образами, как в Life Picture.

Для работы в специальном режиме, xRes требует, так же как и Life Picture, сохранения
файла в своем формате – LRG (Large, очевидно), представляющий из себя, в сущности,
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Т а к и м
образом, пользова-

тель и его маленький ком-
пьютер работают с объемом растровых данных весом не более пары мегабайт и,
если есть слои (в xRes они называются Objects), то до четырех, что, согласитесь,
может пережевать любая машина.

LRG может содержать только одно растровое поле, таким образом не под-
держивает слои (объекты). Когда в вашем проекте стало больше одного объекта и вы
хотите его сохранить, xRes предлагает сохранить каждый объект в формате LRG и свя-
зывающий их файл - в формате MMI (Macromedia Image). Его то вы и открываете, когда
захотите продолжить редактирование «слоенного» файла.

Как я уже упоминал, все операции производятся над экранным образом, причем ис-
ключительно над его видимой частью, даже то, что закрыто палитрами не просчитыва-
ется. Таким образом разворот изображения любого размера (это может быть хоть пол-
гигабайта) на угол не кратный 90 градусам (17, например), достаточно тяжелая опера-
ция, требующая серьезных вычислений, производится за несколько секунд!

Неудобством xRes является задержка в 1-2 секунды, происходящая из-за обновле-
ния экранного образа следующая чуть ли не за любым действием: изменение масшта-
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что-то вроде базы дан-
ных. На ее основе, на
этапе обработки, гене-
рируется экранное
представление с экран-
ным же разрешением.



ба, перемещение всех видов окон (в том числе палитр) и, конечно, преобразования изо-
бражения. Этого недостатка нет в Life Picture. Другой минус xRes, причем довольно се-
рьезный, это невероятная прожорливость (другого слова не подобрать) его файла под-
качки, который легко достигает нескольких сотен мегабайт и дальше.

По окончании работы выполняется экспорт в один из стандартных форматов. Этот
процесс напоминает визуализацию (Rendering) 3D и анимационных программ. На этом
месте xRes задумывается и на долго.

Последняя версия xRes – третья… и последняя. По каким-то причинам Macromedia
отказалась от дальнейшей разработки этого продукта, а жаль.
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Святые мощи

Adobe Illustrator – пасынок Adobe. Такое впечатление, что его делают одни люди, а
все остальные продукты компании – другие. Из версии в версию кочуют странные недо-
работки. Если CorelDRAW, практически, самодостаточен, во FreeHand’е (в паре с
Photoshop’ом) можно сделать, что хочешь, то одна такая удивительная вещь, как отсут-
ствие поддержки многостраничности делает Illustrator вспомогательным приложением,
к которому обязательно требуется программа обработки растра и верстки. Так же удив-
ляет его система работы со шрифтами. Многие первые версии Illustrator’а (на РС –
вплоть до седьмой) могли использовать только шрифты Type 1. До сих пор нужна мощ-
ная видеокарта, чтобы в Illustrator’е не тормозилась перерисовка экрана.

Тем не менее в Америке и России Illustrator имеет большее распространение, чем
FreeHand. Существует что-то вроде фан клубов Illustrator’а, один из них расположен на
московском сервере www.illustrator.ru. Он (Illustrator) обладает каким-то внутренним
обаянием (как Macintosh), если так вообще можно сказать о программе. В полной мере
оправдывает свое название – в нем, действительно, очень удобно готовить векторные
иллюстрации. Правда, к сожалению, в Illustrator’е, нет эффектов прозрачности как в
CorelDRAW или FreeHand’е, зато присутствует очень мощный и гибкий инструмент
Paintbrush, позволяющий, в частности, достаточно достоверно имитировать мазки кис-
ти. У инструмента Gradient Mesh нет аналога в конкурирующих программах. Так именно
с его помощью были мной нарисованы иллюстрации на тему компьютеров, использо-
ванные в оформлении рубрики МасАДЕМИЯ и в новом дизайне iNTERface.

Так же Illustrator открывает на редакцию любые файлы EPS, который является его
родным форматом. Его интерфейс, горячие клавиши соответствуют стандарту Adobe,
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что сильно облегчает изучение и использование Illustrator’а пользователям Photoshop.
Во многом на базе Illustrator’а Adobe разработала новый пакет верстки InDesign, кото-
рый называют «убийцей Quark’а». Все три программы войдут в следующую версию па-
кета Adobe Graphics Studio, выходящего летом, когда будет выпущен окончательный ре-
лиз InDesign и представляют из себя мощнейший комплекс для дизайна и верстки из су-
ществующих на рынке.
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Бубен шамана

Microsoft Word 98. (в роли шамана выступает сами знаете кто). Собственно говоря,
Word я не знаю настолько, чтобы писать о нем, но кое-что полезное для читателей
iNTERface о нем сообщить могу.

Office 98 – последняя версия этого всемирно известного пакета, вышедшего в про-
шлом году только для Macintosh. Я не буду здесь рассказывать грязную историю по то,
как агенты дядюшки Билла шантажировали Apple возможностью появления Office 98 на
платформе Macintosh в  обмен на отказ от выхода на Windows QuickTime 3, с возмуще-
нием рассказанную мне Мишей Грином (МасАДЕМИЯ). Остановлюсь только на малень-
ком вопросе, уже дважды поднимавшемся на страницах газеты: как перебросить рус-
ские тексты с Мака на РС и назад?

Для этого необходимо:
• Microsoft Word 98 на Макинтош,
• русификатор для Мака Apple Cyrillic Kit,
• Microsoft Word 97 на РС
• Дискета
Apple Cyrillic Kit устанавливает в систему несколько своих шрифтов: Прямой Проп,

Бастион, Латинский и некоторые другие. Текст, написанный с их использованием в Word
98, открывается в Word 97 с сохранением всего форматирования, кадров и пр. Нужно
только выбрать все и заменить ненайденный в системе маковский шрифт каким-нибудь
писишным. Точно так же осуществляется перенос текста с РС на Мак.

Пользователи русификатора cRussify 2.5 имеют возможность пользоваться всеми
русифицированными шрифтами, установленными в системе. cRussify 2.5 можно бес-
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платно выгрузить с сайта www.macintosh.ru. Возможно, описанный прием работает так
же с Word 95, с другими маковскими системами русификации, я не проверял.

Относительно иврита, к сожалению, есть плохие вести. Израильское отделение
Microsoft не планирует локализацию Office 98. Они считают, что не смогут окупить про-
деланную работу, т.к. Маки до сих пор считаются израильтянами компьютерами только
для графики, ввиду инертности их мышления и неудовлетворительной работы Apple-
центров по рекламе Макинтош.

В целом, Office 98 оставляет очень приятное впечатление, так говорят специалисты и
я к ним присоединяюсь. Правда, пишут, что Word 98 тяжелая программа, требует ресур-
сов чуть ли не столько же, сколько Photoshop :), но на моем G3 (что это, читайте в
МасАДЕМИИ) торможения незаметно.

Нужно признать, что на этот раз Microsoft по-настоящему постаралась для Макин-
тош. Спасибо.
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Живая вода

Adobe не стоит на месте. Одна из последних разработок – программа ImageReady и
ImageStyler, предназначенные для подготовки интернетовской графики.

ImageStyler рассчитан на широкие массы пользователей, в его среде можно от и до
подготовить графику интернетовского сайта.

ImageReady является, фактически, приложением к Photoshop’у и ориентирован на
профессиональное использование. Понима-
ет формат пятого Photoshop’а, со всеми но-
выми «примочками», как то: текстовые слои,
эффекты слоев, палитра History, сохранена
палитра Actions. 

ImageReady – это урезанный Photoshop,
где оставлены и развиты только функции, ка-
сающиеся Web-дизайна. Палитра Channels
перестала существовать, альфа-канал добав-
ляется из меню Layer к каждому слою отдель-
но и сильно напоминает функцию маски слоя. Появились возможности оптимизации
графики для форматов GIF, JPEG, PNG-8 и PNG-24. Само окно открытого файла имеет
две вкладки: Original и Optimized (названия говорят сами за себя). Внизу, в двух раскры-
вающихся списках, можно определить, чтобы программа показывала расчетное время
загрузки при разных скоростях соединения, оригинальный/оптимизированный размер
файла и др. Палитра Optimize позволяет выжать из изображения все лишнее, палитра
Optimized Colors показывает все использованные в GIF и PNG-8 цвета. Можно отдельно
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сохранять оригинальную и оптимизированную версию.
В ImageReady очень просто и удобно решена GIF-анимация, а так же система сохра-

нения из многослойных PSD-файлов интернетовских форматов: плющить изображение
не нужно, совмещенная копия всех видимых слоев делается автоматически.
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Pathfinder

Напоследок я оставил пару простых, но очень полезных программок. Отгадайте с од-
ного раза, чьи они? Конечно Adobe! Они решают две проблемы. Adobe Streamline – трас-
сировка растровой графики (перевод ее в векторное представление) и Adobe
Dimensions – трехмерные построения.

«Разве мало 3D-программ?» – спросят знатоки и любители. Полно. Только вся об-
ласть трехмерной графики и анимации настолько сложна, что занимающийся ею серь-
езно уже не может заниматься ничем другим. Поэтому Adobe разработала вспомога-
тельную программу, которая выполняет простые (и посложнее) 3D-построения, может
натягивать растровые карты на объекты, легко обменивается данными с Illustrator’ом
(FreeHand’ом, CorelDRAW через формат Illustrator’а) и с Photoshop’ом. Очень проста в
освоении.

Последняя версия для Macintosh и Windows – третья и что-то давно не было обновле-
ний. Краткое описание принципа работы Adobe Dimensions можно найти у меня на
сайте.

Adobe Streamline – маленькая, предельно простая программа для трассировки. Хо-
рошая трассировка растра – это максимальная точность с минимальным количеством
узлов в кривых. Процесс трассировки основан на поиске цветовых и тоновых контрас-
тов. Все известные векторные редакторы имеют встроенную функцию трассировки, но
выполняют ее плохо. В пакете CorelDRAW 7 была конкурирующая программа Corel OCR-
TRACE, которая умела даже английские тексты распознавать, тем не менее, по качест-
ву трейсинга, заметно уступала Streamline.

Как работает Streamline? Говорить тут, собственно, нечего: нажимаем Ctrl (Cmd)+R,
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готовую работу сохраняем в формате Adobe Illustrator 3, открываем в любой программе.
Все.

*     *     *

Post Scriptum: необразованному читателю родительски объясню смысл некоторых
упомянутых вещей. Как святые мощи оказались среди алхимических и всяких там вол-
шебных приспособлений? И что такое Pathfinder? 

Pathfinder (следопыт) – марсоход из последней американской экспедиции на Марс.
Так же Pathfinder’ом называется группа фильтров для работы с векторами в Adobe
Illustrator. Path, по-английски, и есть вектор.

Святые мощи. Как им не оказаться в колдовской и магической компании, если прин-
цип действия у них совершенно сходный. В былые времена народ всякие талисманы но-
сил, состриженные волосы прятали, верили в способность рога единорога отличать от-
равленное вино. Так же точно мощи праведников носили по зараженным чумой городам
Европы, полагая, что они исцелят людей.

Кто со мной не согласен, могут писать на alexey@kletsel.net.
О смысле других подзаголовков (и разделов :-)  пусть читатель догадывается сам.
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